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Welcome

Welcome to WordPerfect®. WordPerfect 6.0 for DOS—the new version of the world’s best-
selling word processing software—is the most revolutionary WordPerfect yet. Its new and
enhanced features, coupled with an optional graphical editing mode, make it more
powerful, yet easier to use than ever. Getting Started gives you all the information you
need to install and start using WordPerfect.

Registering
WordPerfect

Before continuing, please take a minute or two to fill out the Certificate of License
Registration card and return it to WordPerfect Corporation. That way, you'll receive
important software and information update notices.

Your license number is proof that you own a legal copy of WordPerfect. It may be needed
when you call Customer Support, and it will be required if you upgrade to a new version of
WordPerfect or order replacement disks.

If you have licensing questions, you can call Customer Registration at the following
number:

Customer Registration (801) 222-4555 (toll)

Installing WordPerfect

This section contains the information you need to install WordPerfect, including the
following:

» System Requirements

¢ Installing WordPerfect on a Hard Disk

¢ Installing WordPerfect on a Network

* Questions and Answers About Installing

System Your computer system must have the following for you to install and run WordPerfect 6.0
Requirements for DOS.
Minimum Requirements
* Personal computer using a 286 processor
* 480K free conventional memory
* DOS 3.1 or higher
¢ Hard disk with 7M free disk space for minimal installation
IMPORTANT: You will not be able to use some advanced functions if you run WordPerfect
6.0 for DOS using the minimum system requirements.
Recommended Requirements
* Personal computer using a 386 processor
¢ 520K free conventional memory
¢ DOS 6.0 (or an earlier version with a memory management program)
¢ Hard disk with 16M free disk space for complete installation
* VGA graphics adapter and monitor
Installing Because WordPerfect files are in compressed format, you must use WordPerfect’s
WordPerfect on a installation program to place the files on your hard disk. You'll follow the same steps
Hard Disk whether you're installing WordPerfect for the first time or as a new (upgrade) version.
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To install WordPerfect to your hard disk,



1 Insert the Install 1 disk into drive A (or drive B).
2 Atthe DOS prompt, type a:install (or b:install), then press Enter.

3 Read the on-screen instructions carefully and follow the prompts to finish installing
WordPerfect.

We recommend the Standard Installation for most users. For more information about
installation options or answers to other questions you may have while you're installing
WordPerfect, refer to Questions and Answers About Installing later in this section.

IMPORTANT: When you've finished installing the program to your hard disk, put the
original disks in a safe place. Avoid exposing them to sunlight, dust, and magnetic fields
(even televisions, telephones, and stereo speakers contain magnets). If one of the original
disks becomes damaged or lost, you may not be able to recover the contents of that disk.

Installing
WordPerfect on a
Network

This section is for the network supervisor who is responsible for installing programs on the
network. You can skip this section if you're not installing WordPerfect on a network.

What You Should Do Before You Install WordPerfect

» Ensure that you have sufficient rights or privileges to the drive on which you are going
to install. For example, you should be able to copy, rename, write, delete, read, and
create files.

* Check to see that at least 16M of disk space is available for a complete installation.

 Verify that the drive letters you specify during installation are consistent with those that
are available on your server.

¢ Make sure the total number of WordPerfect copies in use does not exceed the number
printed on your Certificate of License. If you need more copies than your license
allows, call the WordPerfect Orders Department to order additional licenses. This
number is listed under WordPerfect Corporation Customer Services at the end of this
guide.

IMPORTANT: Map a search drive to the WordPerfect program directory before you install.
Only one search drive is needed to run WordPerfect on Novell NetWare.

Starting Install

1 Make sure the destination resource (or drive) to which you intend to install WordPerfect
isavailable.

2 Insert the Install 1 disk into drive A (or drive B).
3 Atthe DOS prompt, type a:install (or b:install), then press Enter.

4 Read the on-screen instructions carefully and follow the prompts to the Installation
Options, then choose Network Installation.

5 Continue to follow the prompts to finish the installation.

6 If you need help, call WordPerfect Customer Support at the Networks number listed
under WordPerfect Corporation Customer Services at the end of this guide.

What You Should Do After You Install

¢ Use your network’s security system to secure files that are critical to the operation of
WordPerfect before it is used regularly on the network.

¢ Share the WordPerfect directories with (or make them accessible to) all users on the
network.

¢ Set up each user’s workstation by including SET and redirection commands in
AUTOEXEC.BAT, network profiles, or login scripts as you deem necessary.
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Viewing README.NET

The README.NET file contains information about networking WordPerfect that was not
available when this guide was printed. This file, which can be printed, has current
information on how to troubleshoot network problems and fine-tune WordPerfect on the
network.

Setting up Environment Files

A network installation creates an environment file for WordPerfect. Environmentfiles
contain startup options that let WordPerfect operate as networked software. See
Appendix L: Networking WordPerfect in Reference for more information.

Questions and
Answers About
Installing
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Installing W ordPerfect

The following are answers to questions you may have about installing WordPerfect.

Do I need to delete earlier versions of WordPerfect before I install?

No. A Standard Installation places the 6.0 version in a different directory than earlier
versions. Just make certain the PATH= statement in your AUTOEXEC.BAT is referencing
only one installation of WordPerfect (for example, either C:\WP51 or C:\WP60).

If your disk space is limited, you can delete your earlier version of WordPerfect and then
install WordPerfect 6.0. Be sure to copy documents, styles, graphics, and macros you
want to use in WordPerfect 6.0 to a new directory before deleting the earlier version of
WordPerfect.

Which installation option should I choose?

The Standard Installation is the recommended installation option for most users, whether
you are installing WordPerfect for the first time or as a new (upgrade) version.

The following table shows which installation option to choose:

Installation Option Use

Standard Installation To install WordPerfect for the first time, or to install
WordPerfect for a new (upgrade) version

Custom Installation To perform a minimal installation, to install only part of the

program (such as printer or Learn files), or to install sets of
files to directories you specify

Network Installation To install WordPerfect for use by many users on a
network

When installing WordPerfect, a prompt tells me that I don’t have enough room to
install all the WordPerfect files. What should I do?

You can exit the installation program and delete unnecessary files from your hard disk to
make more disk space available, or you can choose a Custom Installation that lets you
select those files you want to install.

Several files, such as Learn files, Speller and Thesaurus files, and sound driver files are
not required to run WordPerfect. For example, if you don’t intend to use the lessons in
Learning WordPerfect, you don’t need to install the Learn files. Or, if your computer isn’t
set up for sound, you don’t need the sound driver files. Of course, these files can be
added later through a Custom Installation. See Appendix M: Program Files in Reference
for a list of the files necessary to run WordPerfect.

What happens to the files I created with earlier versions when I install WordPerfect
6.0?

Nothing. Installing WordPerfect 6.0 creates a new directory (C:\WP60) rather than copying
over files in an existing directory that contains an earlier version. You can then run either
WordPerfect 6.0 or an earlier version of the program.

If you choose to delete an earlier version of WordPerfect before installing WordPerfect 6.0,
copy any files you want to keep to a different directory.



What is the WPC60DOS directory?

WPC6B0DOS is a shared location directory. This directory contains several files, such as
Grammatik, Speller, Thesaurus, and fonts.

How can I conserve disk space?

You can choose Minimal Installation under the Custom Installation option to install only the
files necessary for running WordPerfect. This option requires a minimum of 7M of free
disk space and does not install the Learn files, Speller, Thesaurus, Grammatik, macros,
graphics, and preset Button Bars.

You can also choose Custom Installation and install the program files plus any other files
you want.

After you install, you may be able to delete some files, depending on your computer setup.
See Appendix M: Program Files in Reference to see which files you can delete.

Can I use styles, macros, and keyboards I created with WordPerfect 5.1 in
WordPerfect 6.02

You can use any styles you created with WordPerfect 5.1. Simply retrieve the
WordPerfect 5.1 files into WordPerfect 6.0, and the program automatically converts these
styles so you can use them in WordPerfect 6.0.

You can also use any macro you created in WordPerfect 5.1. WordPerfect 6.0 comes with
a macro conversion program that converts your macros, although you may need to edit
some complex macros after you've converted them. See the Online Macros Manual
(choose Macros from the Help menu).

You cannot use keyboard layouts from an earlier version.

What is a printer driver and why should I install it?

A printer driver is a file that lets you print to a specific printer. Before you can print
documents from WordPerfect, you need to install the appropriate printer driver. You can
install printer drivers when you install WordPerfect or at a later time.

While you're installing WordPerfect, each installation option lets you install printers. You
can choose your printer from a list of available printer drivers. If your printer is not listed,
WordPerfect may still have a printer driver you can order for your printer. See
WordPerfect Corporation Customer Services at the end of this guide for information about
ordering additional printer drivers.

If you have installed WordPerfect and want to add an additional printer driver at a later
time, find the disk labeled Install 1 that came with your original WordPerfect 6.0 package.
Follow the installation instructions as described earlier in this section until you come to the
WordPerfect 6.0 Installation screen. Choose Device Files under Miscellaneous Options,
then follow the online prompts to install the printer driver(s) you want from the Printer
Driver(s) options. This procedure installs only the printer files you select.

Iinstalled printer drivers for an earlier version of WordPerfect. Can I use the same
drivers?

While you can convert printer files to use with WordPerfect 6.0, we do not recommend
using printer drivers from earlier versions of WordPerfect. A Standard Installation of
WordPerfect 6.0 installs updated printer files with your program.

I chose Minimal Installation from the Custom Installation option. Why can’t I run
the Speller, Thesaurus, or Grammatik?

A Minimal Installation will install only those files necessary to run WordPerfect. If you want
to install writing tools such as Speller, Thesaurus, or Grammatik, choose Custom
Installation, then install the files you want.

Installing WordPerfect 7



What are the README files?

README files contain information about program changes made after this guide was
printed. You can view README by retrieving them in WordPerfect or any text editor. You
can also print them. The names of the files begin with “README.”

I accidentally deleted some WordPerfect files. Can I reinstall only part of
WordPerfect 6.02

Yes. Start the Install program, choose Custom Installation, then select those files you
want to reinstall.

Using WordPerfect

The way you start WordPerfect depends on your computer setup. You can start
WordPerfect from a DOS prompt, from a Shell program such as WordPerfect Shell, or
from a graphical environment such as Windows or OS/2. This section contains the
following:

Starting WordPerfect from a DOS Prompt
Starting WordPerfect from Shell

Entering Your Customer Registration Number
Using the Mouse and the Keyboard

Working in WordPerfect

Exiting WordPerfect

For information about running WordPerfect under an alternative operating system, see
Appendix N: Running WordPerfect Under Windows and OS/2 in Reference.

Starting 1 AtaDOS prompt, type cd\wp60 (or, if you installed WordPerfect to a directory other
WordPerfect from than wp60, type the name of the directory after the backslash [\]).
a DOS Prompt 2 Press Enter.
3 Type wp, then pressEnter.
Starting Before starting WordPerfect 6.0 using a Shell program, you must first install the Shell

WordPerfect from
Shell

8 Using WordPerfect

program. Once you've installed Shell,
1 Change the DOS prompt to the drive and directory containing the Shell program file.
2 Type shell, then pressEnter to start the Shell program.

3 From the Shell menu window, type w to start WordPerfect (or, if you have assigned a
program letter other than “w” to WordPerfect, type that letter instead).

See your Shell manual for more information about using WordPerfect with Shell.



Entering Your The first time you start WordPerfect, you are prompted for your customer registration
Customer number.

Registration
Number
WordPerfect
To have your customer registration number conveniently
displayed whenever you choose WP Info from the Help
pull-doun menu, type the registration number now and
press Enter. Example: ﬂi‘ﬂ_‘ﬁ_l 456769 :
1 Enter your customer registration number, then press Enter.
You can find your registration/license number on your Certificate of License. Once you've
entered a registration number, you can choose WP Info from the Help menu to view or
edit the number.
Using the Mouse Before you start creating documents with WordPerfect, you should learn how to use the
and the Keyboard mouse and the keyboard. You do not need a mouse to use WordPerfect. If you don’t

have a mouse, you can skip the following section, Using the Mouse.

Using the Mouse

You can use the mouse to quickly block text, choose commands from menus and dialog
boxes, and complete almost any other task in WordPerfect.

When you move the mouse, a graphic image called a pointer moves on the screen. In
Text Mode, the mouse pointer appears as a small rectangular box. In Graphics Mode, the
mouse appears as an arrow.

I %— Mouse pointer in Graphics Mode

As you work through this guide and in other WordPerfect manuals, you may be instructed
to perform actions with your mouse. The following terms are used when you need to
perform such actions. These mouse actions refer to the left mouse button, unless the
directions specify the right mouse button.

Mouse pointer in Text Mode

Term Action

Point Move the mouse until the mouse pointer rests on the item you
want.

Click Quickly press and release the mouse button.

Double-Click Rapidly click the mouse button twice.

Drag Hold down the mouse button, move the mouse, and then release
the button.

Choose Click an item from a menu or dialog box that initiates an

immediate action.

Using WordPerfect 9



Term Action

Select Click an item (such as a check box in a dialog box) to highlight or
mark it.

PROBLEM? If your mouse is connected to your computer but doesn’t work, you should
use the Setup feature. Choose Setup from the File menu, then choose Mouse. Select
Type, then Auto Select. Choose OK to return to your document. Try moving the mouse.
If a mouse pointer doesn’t appear on your screen, see Mouse in Reference.

Using the Keyboard

Almost everything you can do with a mouse you can do from the keyboard. Function keys
and mnemonics, as defined below, appear on menus and in dialog boxes, indicating the
keyboard commands for the task you want to perform.

Function keys provide quick access to features in WordPerfect. The plus sign between
keys (such as Shift+F7) means that you need to hold down the first key while pressing the
second. A comma between keys (such as Home,Up Arrow) means to release the first
key before you press the second.

Mnemonic letters (such as P for Print) let you activate menus and dialog boxes. You can
display pull-down menus from the main screen by holding down the Alt key and pressing
the mnemonic letter for the menu you want (such as Alt+f for the File menu).

Text you are asked to type is printed in bolded lettering.

Working in
WordPerfect

Menu bar

When you start WordPerfect, a new document window opens. Think of this window as a
clean sheet of paper with margins and spacing already set. You can open up to nine
document windows at one time. For more information, see Windowing in Reference.

Cursor flashing, indicating
point of insertion

Status line showing document,
page, line, vertical position, and
horizontal position of the cursor

File Edit View Layout Tools Font Graphics Window Help

10 Using WordPerfect
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Menus

As you use the WordPerfect menus on the menu bar, you'll notice that some menu items
perform functionsimmediately, while others open dialog boxes or cascading menus. A



menu item followed by three dots (...) opens a dialog box or special window. A menu item
followed by an arrow (»>) opens a cascading menu.

WordPerfect File menu

Indicates this menu item opens a
dialog box

Selected item in a menu is
highlighted

+—— Indicates this menu item opens a
cascading menu

Mnemonic

Shortcut key

Function keys (also called shortcut keystrokes) are listed next to many menu items. Once
you know the shortcut keystroke for a function, you can simply press that keystroke
instead of using the menus to access that feature.

Mnemonics (bolded or underlined letters) let you access items from the keyboard. Hold
down the Alt key while you type the mnemonic of the menu you want to open. Then type
the mnemonic for the menu item you want to use without pressing Alt. For example, to
turn on Bold you would press Alt+o for Font, then type b for Bold.

To back out of a menu without choosing an item, press Esc.

Dialog Boxes

Dialog boxes let you communicate with the WordPerfect program. Like menus, dialog
boxes contain mnemonics. To access a dialog box option, simply type the mnemonic for
that option. You can choose Cancel (or press Esc) to exit a dialog box without executing
the options you selected.

A marker shows a selected radio
button

An “x” shows a selected check
box

Mnemonic

The Cancel push button lets you
exit the dialog box without
executing the options you have
selected

Arrow indicates a drop-down
list box

The OK push button lets
you confirm your changes
and close the dialog box

Most dialog boxes must be closed before you can work in the document window, but a
few, such as Edit Button Bar and WordPerfect Characters, let you move between the
window and the dialog box by clicking on the one you want to use.

Printing

To print a document in WordPerfect, you must first select a printer and specify which port
you are using. If you used the Standard Installation option to install WordPerfect, you
likely selected a printer at that time. If a printer is not selected or if you want to change the
printer that is currently selected, choose Print/Fax from the File menu, then choose
Select. Highlight the printer you want to use, then choose Select. Choose Close to
return to your document. If you have trouble selecting a printer, see Print: Select Printer in
Reference.

Using WordPerfect 11



The printer you select will be in effect for all new documents. If you need to add additional
printer drivers to WordPerfect, see Installing WordPerfect earlier in this guide.

Exiting WordPerfect

You should exit WordPerfect before you turn off your computer.

1 Choose Exit WP from the File menu.

Exit WordPerfect

.. Save Filename
Ac bl b
nark ALl | Exit |

The Exit WordPerfect dialog box appears when
you exit WordPerfect.

Save any changes you want to your document before exiting.
2 Choose Exit.

WordPerfect is no longer running, and you have returned to the DOS prompt (C:\WP60) or
to the program from which you started WordPerfect.

Questions and Answers

This section contains answers to many of the questions you may encounter when running
WordPerfect 6.0 for DOS. It includes the following topics:

File Compatibility
Fonts

License Numbers
Macros

Memory

Printing

Screen Display
Speed

For a more comprehensive list of questions or problems, see Appendix R: Troubleshooting
in Reference.

File Compatibility
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How do I convert WordPerfect document files that were created in earlier versions
of WordPerfect?

Documents created in earlier versions of WordPerfect are compatible with WordPerfect 6.0
and are automatically converted as they are opened or retrieved in WordPerfect.

How do I convert documents that were created in word processors other than
WordPerfect?

Open or retrieve the document, and WordPerfect 6.0 will detect the document format, even
if itis not in WordPerfect format. The Convert File Format dialog box appears, with the
format of the file highlighted.

If WordPerfect does not list the exact format of your document when you open it, select the
closest format. For example, if you have an Ami Pro 3.0 document, select the Ami Pro 2.0
format. WordPerfect will then convert compatible codes to the 2.0 format. When you are
finished editing the document, save it as a WordPerfect file. Otherwise, the file will be
saved in the original file format.



Can I use the same Speller files for WordPerfect 6.0 that I used in WordPerfect 5.1?

No. You cannot use the WordPerfect 5.1 main dictionary (.LEX file) in WordPerfect 6.0. If
you created a supplementary dictionary (.SUP file) in WordPerfect 5.1, you can retrieve it
into WordPerfect 6.0 and then run a spell check on it. This lets you add these words to
your WordPerfect 6.0 supplementary dictionary.

Can I use the same Language Modules for WordPerfect 6.0 that I used with
WordPerfect 5.1?

No. If you purchased Language Modules for WordPerfect 5.1, you must update them for
WordPerfect6.0. For information on updating your Language Modules, call WordPerfect
Orders. This number is listed under WordPerfect Corporation Customer Services at the
end of this guide.

Fonts

Why don’t my screen fonts look the same as my printed fonts?

WordPerfect lets you view documents in three different modes: Text, Graphics, and Page.
Text Mode displays your document in monospaced characters, similar to the display of
earlier versions of WordPerfect. The screen characters do not reflect the type of font or
the font size you're using in your document.

Graphics Mode and Page Mode imitate a WYSIWYG (What You See Is What You Get)
environment. WordPerfect displays your document closer to the way it will look when it
prints. When you are typing, WordPerfect matches the fonts you see on the screen as
closely as possible to your printer fonts. Attributes such as italics, bold, and underline
appear italicized, bolded, and underlined. If you don't like the printer fonts WordPerfect
matches with the fonts you see on your screen, you can map your own fonts. See Font
Setup in Reference.

1 use a third-party font program with other programs. Can I use these fonts in
WordPerfect 6.02

WordPerfect 6.0 supports the following font types: Autofont, Bitstream Speedo, CG
Intellifont, Type 1, TrueType, and HP LaserJet (Bitmapped Fonts). If your third-party font
program falls within one of these font types, you can easily install your font to WordPerfect
using Font Setup. See Font Setup in Reference for more information about installing
fonts.

License Numbers

I lost my license card. Can I get a new license?

If you can provide proof of purchase, WordPerfect will send you a new license number.
For more details, contact Customer Registration. See the phone number listed under
Welcome at the beginning of this guide.

Macros

Can I use macros I created with WordPerfect 5.1 in WordPerfect 6.0?

Yes. WordPerfect 6.0 comes with a macro conversion program that converts your macros.
With some complex macros, you may need to edit the macro after you've converted it.
See the Online Macros Manual for more information (choose Macros from the Help
menu).

Where is the macros manual?

WordPerfect 6.0 comes with an extensive Online Macros Manual. While running
WordPerfect, choose Macros from the Help menu to access the Online Macros Manual.
For a quick list of macro commands, you can press Ctri+PgUp, then choose Macro
Commands.

I can’t use my Ctrl key to name macros. Why?

WordPerfect reserves the Ctrl key for use in development. You cannot name a macro
using the Ctrl key. You'll also notice that WordPerfect uses the Alt key in combination with
certain keys to access pull-down menus. For example, Alt+f accesses the File menu. If
you use keystrokes, you may not want to name macros using the Alt key with those keys
that access pull-down menus.
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If you do create a macro using the Alt key with a key that accesses a pull-down menu, the
macro keystroke will override the menu option.

Memory

Why do I keep getting Out of Memory messages?

Your computer’s memory may be insufficient for the tasks you are trying to perform.
WordPerfect requires a minimum 480K of the available conventional memory in your
computer to run (we recommend at least 520K).

To find out how much memory you have available, choose WP Info from the Help menu
when running WordPerfect. See Memory in Reference for more information.

You may need additional memory when you work with large files or perform certain
functions, such as converting documents, printing, working with graphics, or using Speller
and Thesaurus. You can purchase a memory manager and expanded or extended
memory to make more conventional memory available. See your local vendor or dealer.

Another possibility is that your system is not configured properly. If you have configured
your memory as expanded rather than extended, or if you have allocated too much
memory to the RAM drive, your computer may not have enough memory to perform. For
more information on configuring your system, see your DOS manual.

Printing

Can I use the same printer files in WordPerfect 6.0 that I used for earlier versions?
While you can convert printer files to use with WordPerfect 6.0, we do not recommend
using printer drivers from earlier versions of WordPerfect. A standard installation of
WordPerfect 6.0 installs updated printer files with your program.

What should I do if I’m experiencing printer problems?

See Appendix R: Troubleshooting in Reference. It contains sections on printing tips and
common problems and solutions. If you continue to have problems, feel free to call
Customer Support.

Screen Display

Why does WordPerfect sometimes make my text spread out so much that I have to
scroll back and forth to read it all?

If you are in Text Mode and have selected a small font or a proportionally sized font, the
text may extend beyond the edge of the screen, requiring you to scroll back and forth.
Since Text Mode doesn’t display the fonts as they will be printed, the screen must shift with
some fonts to fit all the characters that will be printed on one line.

Text does not extend beyond the screen in Graphics Mode or Page Mode since fonts
appear on the screen as they will be printed.

How can I scroll from left to right?

You can select Horizontal Scroll Bar from the View menu so that a scroll bar displays at
the bottom of the screen. You can then drag the scroll bar with your mouse.

You can also use the arrow keys to scroll across the screen. See Cursor Movement in
Reference for more information about cursor movement and scrolling.

Speed
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What can I do to speed up WordPerfect 6.0 for DOS?
To make WordPerfect run faster, you can do the following:

* Add memory to your system. WordPerfect requires a minimum of 480K available
conventional memory (520K recommended).

* Use a disk cache program.
* Remove any Terminate and Stay Resident (TSR) programs.

¢ Use the /R startup option to load the entire WP.FIL file into expanded or extended
memory.

* Use a memory manager program to make more conventional memory available.



* Use Text Mode rather than Graphics Mode or Page Mode.

¢ Limit the number of document windows open at one time (you can have up to nine
open).

¢ Avoid extra large documents. Consider dividing documents over 50 pages into smaller
files.

Getting Help

Everyone needs help on occasion. If you have problems using WordPerfect, you can get
help from several different sources. This section explains the following:

Using the Manuals

Understanding Manual Conventions
Using Online Help

Using README Files

Calling Customer Support

Using the Manuals

You can use WordPerfect's manuals to answer questions you have when using
WordPerfect. Your WordPerfect package contains Getting Started, Learning WordPerfect,
Reference, and the Shell User’s Guide.

Getting Started

The Getting Started guide shows you how to install WordPerfect and gives you a general
introduction to the program. It discusses terms and conventions you should be familiar
with as you use WordPerfect and provides answers to questions commonly asked by
users.

Learning WordPerfect

Learning WordPerfect helps you learn how to create and format a variety of documents
using WordPerfect. This manual is useful if you're new to word processing and to
WordPerfect.

Reference

Reference can answer questions you have as you use WordPerfect. Each of the
alphabetically arranged task-oriented sections includes general steps for using the feature,
as well as additional information when needed.

Shell User’s Guide

The WordPerfect Shell User’s Guide contains basic information for using the Shell
program with WordPerfect 6.0 and other WordPerfect products.

Understanding
Manual
Conventions

As you read through this guide and other WordPerfect manuals, you should understand
the following conventions and terms. They will help you locate and interpret the
information you need.

Left Mouse Button

Unless otherwise noted, mouse instructions assume that you are using the left mouse
button. If you are using a left-hand mouse, you will need to use the right button.

Alternate Methods

Although the WordPerfect manuals are written with the mouse user in mind, function keys
or alternate methods for keyboard users are included with steps to allow quick keyboard
access.

Getting Help 15



Cross-References
Cross-references are used frequently throughout the manuals to direct you to more
information. Cross-references can refer you to another area of the section you're in, to
other sections in the same manual, or to a section in another manual. A cross-reference
can appear as follows, depending on where it directs you for more information:

See Setting Tabs later in this section.

See Installing WordPerfect.

See Font Setup in Reference.

Notes
As you use the manuals, you will see three kinds of notes: Important, Problem, and Hint.

IMPORTANT: The important note gives critical information for completing a task or using a
feature. When you see an important note, you should be sure to read it.

PROBLEM? A problem note provides troubleshooting help. For example, the first time you
try to print, you may have a problem. This note would try to help you resolve the problem.

HINT: A hint note provides additional information about using a feature.

Using Online Help

You can use WordPerfect’s online Help system to get immediate information about
WordPerfect features and options without reaching for a manual.

Help Menu
You can access the full range of Help topics using the following items from the Help menu:

Choose Menu Item To Get

Contents List of Help contents and access to the Index, How Do |,
Glossary, Template, Keystrokes, Shortcut Keys, and
Using Help

Index List of Help topics in alphabetical order; choosing a letter
displays a list

How Do | Instructions for performing common tasks. For example, the
user might ask, “How do | Save a Document?”

Coaches Interactive step-by-step instructions to complete tasks using
a selected feature

Macros Online Macros Manual

Tutorial A guided tour of WordPerfect basics

Help Key

You can get help on the feature you’re using by pressing the Help key. The Help key is F1
or F3, depending on the keyboard layout you are using. (F1 is the default for WordPerfect
6.0.)

If you press the Help key in a document window, the Help Contents window displays.

If you press the Help key in a dialog box or on a selected option or highlighted menu item,
Help for that item displays.

For more information about the Help feature, see Help in Reference or Lesson 9: Getting
Help in Learning WordPerfect.

Using README
Files

16 Getting Help

README files contain information about changes to the program that were made after the
manuals were printed. Be sure to retrieve README files into WordPerfect and read
through them.



Calling Customer
Support

If you need assistance beyond what the Help feature and WordPerfect manuals can
provide, feel free to call Customer Support. Customer Support is designed to offer you
fast, courteous service in response to any questions you have about WordPerfect.

Before calling, be prepared to explain your problem. Try to duplicate it, then write down
what happened step by step. Also, be at your computer and try to have the following
available:

e Learning WordPerfect and WordPerfect Reference
¢ Original (master) WordPerfect 6.0 for DOS disks

¢ License number and WordPerfect program date (you can display these by choosing
WP Info from the Help menu)

¢ The brand name, type, and model of your computer, graphics card, and mouse

If your problem is related to your printer or sheet feeder, you need to know:

¢ The brand name, type, and model of your printer and the release date of your printer
(.ALL)file

* The brand name, type, and model of your sheet feeder

To provide you with the most efficient service, we have created specialized support
groups. If you call the number for the group that most closely corresponds to your
problem, we can assist you in a more effective and timely manner. The phone numbers
for Customer Support are listed under WordPerfect Corporation Customer Services at the
end of this guide.

In addition to traditional phone support, WordPerfect Corporation offers a variety of other
support services, such as the WordPerfect InfoShare Fax Service, WordPerfect
Corporation Bulletin Board Service (BBS), and WordPerfect Forums on CompuServe. See
Additional Customer Support Services under WordPerfect Corporation Customer Services.

WordPerfect Corporation Customer Services

Orders

To order WordPerfect 6.0 for DOS or other WordPerfect products, use one of the Orders
numbers listed below. For competitive pricing, see your local reseller. If you're outside the
United States, U.S. Territories, or Canada, please contact your WordPerfect Affiliate office
orlocal reseller.

You can also contact WordPerfect Corporation about the availability and prices of other
product components (such as disks, templates, and manuals), using a number listed
below:

Orders (800) 321-4566 (toll-free)
(801) 226-6800 (toll)

International Information (801) 222-4200 (toll)

Fax (801) 222-5077 (toll)

Supplementary Materials and Services
WordPerfect Corporation offers other supplementary materials and services for

WordPerfect 6.0, including the following:
¢ Additional Coaches, Coaches source files, and documentation on creating Coaches
 Utilities disk (including PTR program, Speller Utility Program, and so forth)
* Additional printer drivers
* Additional graphic drivers

WordPerfect Corporation Customer Services 17



¢ Additional fonts
¢ Macros manual (printed version of the Online Macros Manual)
¢ PTR manual

* Certification program information (for certifying instructors and systems engineers as
well as authorized training centers)

» Training materials (such as course outlines, class exercises, transparency masters,
student handouts, and demonstration files)

You can receive detailed information about the availability and cost of these and other
materials by calling one of the Information Services numbers listed under General
Information at the end of this section or by using the WordPerfect InfoShare Fax Service.
For more information on InfoShare, see WordPerfect Corporation InfoShare Service under
Additional Customer Support Services later in this section.

Customer Support

If you have a question or problem when using WordPerfect, you may want to look at the
Questions and Answers section in this guide and Appendix R: Troubleshooting in
Reference.

If you still can’t find the answer, feel free to call Customer Support or use one of the
additional Customer Support services (such as the WordPerfect InfoShare Fax Service,
the WordPerfect Corporation Bulletin Board Service (BBS), and WordPerfect Forums on
CompuServe) described later in this section.

Before you call Customer Support, be ready to explain your problem or what kind of
information you need. Make sure you're at your computer when you call.

If you're an English version user within the United States, U.S. Territories, or Canada, you
can get toll-free support by dialing the numbers listed below. If you are outside the United
States, Puerto Rico, the U.S. Virgin Islands, or Canada, please contact your local
WordPerfect Affiliate or authorized reseller for customer support.

Installation of WordPerfect Software

For assistance when installing WordPerfect 6.0 for the first time, when installing an
upgrade, or for answers to general installation questions, call the following numbers:

Installation (800) 228-9012 (toll-free)
(801) 228-9954 (toll)

General Features
For assistance when using WordPerfect features, call the following numbers:
Equations, Graphics, Sound, (800) 228-9006 (toll-free)
Tables (801) 228-9952 (toll)
Macros, Merge (800) 228-9013 (toll-free)
(801) 228-9951 (toll)
All Other Features (800) 228-9038 (toll-free)

(801) 228-9950 (toll)

Printing, Faxing, and Using Fonts

For assistance when selecting a printer, setting up print options, or experiencing printing
problems in WordPerfect, call the number below that corresponds to the type of printer you
use. You can also call any of the numbers if you have problems faxing WordPerfect
documents directly from your computer using a fax modem or a fax server on a network.

Laser or PostScript Printer (800) 228-9027 (toll-free)
(801) 228-9955 (toll)

Dot-matrix Printer and All Other (800) 228-9032 (toll-free)

Printers (801) 228-9956 (toll)
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For help with printer hardware problems or when ordering printer accessories, such as toner or font
packages, contact your local dealer.

Networks

If you're a system administrator and you need assistance when installing and
troubleshooting WordPerfect on a local area network (LAN), call the following numbers:

Networks (800) 228-9019 (toll-free)
(801) 228-9953 (toll)

Additional
Customer Support
Services

After-Hours Support

You can receive after-hours support for WordPerfect products by calling (801) 222-9010
(toll). This number is not toll free. You can call during the following mountain standard
time hours:

Monday 2:00 a.m. to 7:00 a.m., 6:00 p.m. to 7:00 a.m.
Tuesday, Wednesday, Thursday 6:00 p.m. to 7:00 a.m.

Friday 6:00 p.m. to 10:00 p.m.

Saturday 8:00 a.m. to 4:00 p.m.

Sunday Closed

WordPerfect Corporation InfoShare Fax Service

If you have a fax machine, you can get information about WordPerfect Corporation
products, supplementary materials and services, and Customer Support solutions to
common problems. Through InfoShare, you can receive documents that contain detailed
information in response to technical questions and problems.

To receive faxed information, dial one of the numbers listed below. You can obtain a
listing of available documents and then use document ID numbers to request the specific
documents you want. You can call either by picking up the handset of your fax machine
and dialing or by using a regular phone and at the end of the message entering the
number of the fax machine to which you want the documents sent.

InfoShare Fax Service (800) 228-9960 (toll-free)
(801) 228-9920 (toll)

WordPerfect Corporation BBS

If you have a modem and communications software package, you can access WordPerfect
Corporation’s Bulletin Board Service (BBS).

You can use the BBS to send questions to Customer Support and enhancement
suggestions to Development. You can also transfer problem files to Customer Support
through the BBS.

Use the following numbers to access the BBS:

BBS (1200 or 2400 baud modems) (801) 225-4414 (toll)
BBS (9600 baud V.32 modems) (801) 225-4444 (toll)

WordPerfect Forums on CompuServe

If you have a CompuServe membership, you can get support in the WordPerfect forums.
Though normal CompuServe charges apply, the forums are free of any surcharges, and
there are no membership fees to access the public set of message sections and libraries.

The WordPerfect forums contain files you can download, including printer drivers, press
releases, product brochures, software change notices, troubleshooting information, and
utilities. The forums also contain information about WordPerfect Corporation services,
such as certified instructor programs, conferences, and software subscriptions. To access
the forums, enter GO WORDPERFECT at the CompuServe prompt.
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Electronic Support for the Hearing Impaired

Customers with a telecommunications device for the deaf (TDD) or teletypewriter (TTY)
may obtain toll-free electronic support Monday through Friday from 8 a.m. to 4 p.m.
mountain standard time.

Electronic Support for (800) 321-3256 (toll-free)
the Hearing Impaired (801) 228-9906 (toll)

WordPerfect Corporation Customer Support Fax

If you have a question or problem using WordPerfect, you can fax your question or a
description of your problem directly to WordPerfect Customer Support at the following
number:

Fax Number (801) 222-4377 (toll)

Direct Correspondence

If you have a question or problem using WordPerfect, you can write directly to WordPerfect

Corporation at the following address:

ATTN CUSTOMER SUPPORT
WORDPERFECT CORPORATION
1555 NORTH TECHNOLOGY WAY
OREM UT 84057-2399

General
Information

For answers to nontechnical questions about WordPerfect Corporation products, call the
following:

Information Services (800) 451-5151 (toll-free)
(801) 225-5000 (toll)
Information Services—French (800) 321-2318 (toll-free)

(801) 222-5050 (toll)
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